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Introduction

Introduction

 
What is PstViewer Lite?
 
PstViewer Lite is an application for viewing MSG, EML, PST, MHT, MHTML and OST files, including those
containing email messages, contacts and tasks. PstViewer Lite does not require MAPI installed on
computer to work with PST and OST files. You can view message headers, bodies, attachments and
perform various actions on them.
 

PstViewer Lite key features
· Viewing headers, bodies and attachments of messages in MSG, EML and PST formats.
· Support for reading PST and OST files without MAPI (Messaging Applications Programming Interface)

installed.
· Ability to view contacts, tasks, appointments, etc.
· Viewing messages with Plain Text, RTF and HTML bodies.
· Lots of possible actions for messages, such as Reply, Forward, Print.
· Advanced search, filtering and file system navigation system.
· Highly customizable user interface with profiles support.
· Command line utility.
· Integration with Windows and default email client.
 

Supported message formats
· MSG - Microsoft Outlook message file; compatible with other programs that use Microsoft's Messaging

Applications Programming Interface (MAPI).
· EML - E-mail message saved by Microsoft Outlook Express, Thunderbird, Lotus, and other e-mail

programs; may also contain e-mail attachments, or files sent with the message.
· PST - Personal Storage Table, file format used to store local copies of messages, calendar events, and

other items within Microsoft Outlook.
· OST - Off-line Storage Table that stores e-mail messages and other data saved by the application from

an Exchange server.
· MHT - MIME Hyper text, external links (such as images, Flash animations, Java applets, audio files)

together with HTML code in a single file
· MHTML - MIME HTML web page archive format used to combine resources that are typically

represented by external links (such as images, Flash animations, Java applets, audio files) together with
HTML code in a single file

 
If you have any comments or suggestions for improving PstViewer Lite, we will be glad to hear your
feedback. Please address your comments to support@encryptomatic.com, Subject "PstViewer Lite
Feedback”.
 

System requirements

System requirements
 
Before installing PstViewer Lite, be certain that your computer meets the following minimum software and
hardware requirements.
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Requirement Description Note

Processor Recommended: 1 gigahertz (GHz)
processor

RAM Recommended: 512 MB

Available Hard Disk Space 55 Mb of available space required on
installation drive

Operating System Microsoft Windows XP Professional
SP3
Microsoft Windows Server 2003
Enterprise Edition SP2
Microsoft Windows Server 2008
Enterprise Edition SP2
Microsoft Windows Vista SP2
Microsoft Windows 7 SP1
 
Microsoft Windows XP Professional
x64 Edition SP2
Microsoft Windows Vista x64 SP1
Microsoft Windows 7 x64 SP1
Microsoft Windows Server 2008 x64
Enterprise Edition SP2
Microsoft Windows Server R2 

Software Windows
Installer

Version 3.1 or later Checked and updated
automatically during
installation

.Net framework Version 2.0 or later for x86 platforms
Version 3.5 or later for x64 platforms

Checked and updated
automatically during
installation

 
 
 

Technical support

Technical support
 
We invite you to use the comment form on our website to submit bug reports, feature requests, and
usability comments. All submitted comments are reviewed by the product manager and given serious
consideration.
 
Visit www.encryptomatic.com/support.

About Us

About Us

Our Mission
To provide solutions that make our customers' lives more enjoyable and secure.

Our Vision
A safe world with the freedom to communicate freely and securely.

http://www.encryptomatic.com/support
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About Us
Encryptomatic LLC is a privately held limited liability company headquartered in the historic downtown
district of the twin towns of Moorhead, MN, and Fargo, ND USA, in heart of the beautiful Red River Valley
of the North, where we enjoy snowy winters, beautiful summers, clean air, great fishing and an abundance
of seasonal outdoor activities. Our average workday commute is about ten minutes.
 
We were founded in 2005 by our President, Darren Leno, a former Product Manager for Microsoft Business
Solutions, and Great Plains Software, Inc.
 
For more information, please visit http://www.encryptomatic.com/about-us/
 

http://www.encryptomatic.com/about-us/
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User interface

User interface

Explorer tree

Explorer tree
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Explorer tree represents a tree of folders, available on your computer and network. Upon clicking on a
folder, containing messages in format, recognizable by PstViewer Lite, these messages will be
enumerated and added to mail list.
 
Explorer tree lists folders, remote computers and network shared folders. Messages located in one of
these places can be added to Mail list either by selecting item in a tree, or by right-clicking an item and
selecting Scan folder from context menu. If Scan folder with subfolders item is checked, messages in
subfolders will be also enumerated.
 
You can refresh folder tree to update display of recently renamed, created or deleted items by clicking 
Refresh button on the toolbar or by selecting it in the context menu.
 
Open in explorer context menu item and toolbar button are used for opening selected folder in Windows
explorer.
 
Properties context menu item and toolbar button shows standard system properties dialog for selected
folder.
 
Add to favorites toolbar button adds selected folder to active node of the favorites tree.
 
Docking functionality can be used to change the default position for the Explorer tree.

Favorites tree

Favorites tree
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Favorites tree is a structure that allows quick access to frequently used folders and messages.
Messages located in one of the folders can be added to Mail list either by selecting item in a tree, or by
right-clicking an item and selecting Browse or Browse with subfolders from context menu.
 
To add folder to favorites, select it in the Explorer tree and click Add to favorites button on the toolbar.
Messages can be added to favorites by dragging them from Mail list into the necessary location in the
Favorites tree.
 
Folders can be manually created in the tree by selecting a node and clicking New folder in the context
menu. New folder will be created as a child of the selected item.
 
Edit item name context menu item can be used to change selected folder's name.
 
Delete context menu item is used for deleting folders in the tree.
 
Docking functionality can be used to change the default position for the Explorer tree.

Mail list

Mail list
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Mail list is a table, containing information about messages in active folder. Messages can be sorted, filtered
and grouped by their attributes.
 
Mail list contains following columns: selector column, file type icon column and message attributes
columns: subject, from, to, CC, BCC, delivery time, submit time, has attachments, internal path, source
format, source path. User can select which columns to show in the table and which to hide.
 
Icons displayed for the messages in Mail list help to differentiate between file types of the messages and
the presence of attachments.
 

Context menu
 

 
Right-clicking on a line in mail list table brings context menu for selected message.
 
Open message context menu item is used to open selected message in a default email client.
 
Mail list view context menu item allows disabling of filtering and grouping capabilities of Mail list
component in case user does not need them.
 
Save context menu item allows user to save selected message in the specified folder preserving the same
file name this message already has.
 
Save message as... context menu item allows user to save selected message in the specified folder with
custom file name.
 
Properties context menu item displays Mail information dialog which shows information about message
header and file properties and allows to view message's raw transport header and MAPI properties tree.
 
Note: Open message, Save message as... and Properties menu items are unavailable when multiple
messages are selected.
 

Advanced Mail list tools
 
Mail list provides powerful tools for sorting, filtering, grouping messages and column management.
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You can select which columns to display in the table by clicking Column Chooser in header context menu
and dragging required columns from Customization window to the table. The order of the columns can also
be changed using drag and drop.
 
 
The simplest way to create filter is to enter a value in one of the fields above the table. The contents of the
table will be filtered according to the inputted data in the corresponding column. Resulting filter can be seen
the the bottom of the table. It can be disabled and cleaned by unchecking checkbox near its description or
clicking [x] button.
 
Another way to filter messages is clicking filter button in the column header (visible when mouse is hovering
the header). It will bring a list of possible values for filter current column. This list will differ depending on
column data type. For example, for subject column filtering values would include "Blank fields", "Non-blank
fields", list of subjects of messages currently in the table and custom filter editor. For received time column
filter would allow selecting date from Date picker control or selecting one of the predefined time-filtering
options like "Earlier this year" or "Last week".
 
Any of the earlier created filter rules can be picked from list, that will appear after clicking on the current filter
rule.
 

 
Filter editor dialog can be used for more advanced filtering rule editing. It can be used either to create filter
from scratch or to modify already created filtering rule. Filter editor can be called by selecting Filter
editor... in column header context menu or by clicking Edit filter button in right bottom corner of the Mail
list if filter is already created.
 
Filter editor creates logical constructs that are used for table filtering. These constructs are one or several
logical conditions united by one of the logical operations (AND, OR, NOT AND, NOT OR). Logical conditions
consist of comparisons contents of the columns with proposed value.
 
 
Message grouping can be done by the values of one or several columns in the table. To perform grouping,
drag the column header into to grouping panel. It is possible to perform grouping by several columns. In this
case, nesting order of the grouping columns will be determined by their relative position in grouping panel. It
can be changed by dragging column headers inside of the grouping panel. To cancel grouping, drag column
headers back into the table.
 
Docking functionality can be used to change the default position for the Explorer tree.
 

Message viewer

Message viewer
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Message viewer displays header, body and attachments of a message, selected in Mail list.
 
Message viewer consists of two main parts - Message header viewer and Message body viewer.
 

Header viewer
 
Message header viewer displays attributes from message header (sender, recipient, CC and BCC fields,
sent and delivery times) and attachments list.
 
Clicking on header fields, containing email address, will result in creating a message in default email client
with selected address as recipient.
 
Clicking on attachment items, opens them in a default application associated with corresponding file types.
Right-clicking on attachments brings context menu for selected object.
 
Open attachment context menu item is used to open selected attachment in a default application (same
action as clicking on item).
 
Open with... attachment context menu item brings Open with system dialog, that allows user to specify
which application will be used to open this attachment (and optionally other files of this type).
 
Save attachment context menu item allows user to save selected attachment item in the specified folder
preserving the same file name this attachment item already has.
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Save As... attachment context menu item allows user to save selected attachment item in the specified
folder with custom file name.
 
Save All attachment context menu item allows user to save all attachment items in the specified folder
preserving the same file names these attachment items already have.
 

Message body viewer
 
Message body viewer displays body of email message. It is displayed with all available formatting, unless
Use plain text option is activated.
 
User can select message body and copy it into different application. If that application supports rich text
editing (i.e. MS Office applications) source formatting of message body will be preserved.
 
Right-clicking on message body displays context menu.
 
Select All message body context menu item selects all text in the message body.
 
Copy message body context menu item is used to copy selected text of the message body into the
clipboard.
 
View source message body context menu item opens file, containing source code of the selected message
in Notepad.
 
Docking functionality can be used to change the default position for the Explorer tree.

Main menu

Main menu
 
Main menu of PstViewer Lite consists of 4 top-level items - File, Mail, View and Help.
 
Please note, that main menu is completely customizable. This article describes elements in order they
are grouped by default. Check User interface tweaks article for more information.
 

File menu
 

 
File menu contains following items:
 
Open menu item is used to open message file of one of the supported formats in PstViewer Lite.
Messages contained in selected file will be listed in mail list.
 
Settings menu item brings Settings dialog, that allows user to set font used in application and interface
reactivity time. See Settings article for more details.



13 / 37

 
Associations menu item allows user to associate MSG, EML and PST files with PstViewer Lite. See File
associations article for more details.
 
Exit menu item closes all messages opened in PstViewer Lite and quits the application.
 

Mail menu
 

 
Mail menu contains following items:
 
Open message menu item is used to open selected message in a default email client.
 
Save menu item allows user to save selected message in the specified folder preserving the same file
name this message already has.
 
Save message as... menu item allows user to save selected message in the specified folder with custom
file name.
 
Delete menu item closes all messages opened in PstViewer Lite and quits the application.
 
Search menu item opens Search window
 
Print menu item prints selected message using default printer and default printing settings.
 
Print preview menu item opens Preview window that allows various settings and customizations related
to the process of printing. Check Print preview article for more information.
 
Reply menu item opens default email client with a reply to a sender of a selected message.
 
Forward menu item opens default email client, forwarding selected message to selected recipients.
 
Properties menu item displays Mail information dialog which shows information about message header
and file properties and allows to view message's raw transport header and MAPI properties tree.
 
Note: see Mail actions section for more information about each of the actions, performed by items of Mail
menu.
 
Note: only Search menu item is available when no messages are present in mail list. Open message,
Save message as..., Reply and Properties are unavailable when selecting multiple messages.
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View menu
 

 
View menu contains following items:
 
Use plain text body menu item switches display of all messages in Message viewer to plain text body.
In plain text mode, contents of message body will be displayed without formatting.
 
Show explorer tree menu item toggles visibility of Explorer tree panel.
 
Show favorites tree menu item toggles visibility of Favorites tree panel.
 
Show mail list menu item toggles visibility of Mail list panel.
 
Change docking to default item allows user to set all panels to default positions.
 
Customize menu item opens Customization window with menu and toolbar options. See User interface
tweaks article for more details.
 
 

Help menu
 

 
Help menu contains following items:
 
Registration menu item opens dialog that allows to register your copy of application.
 
Buy now menu item opens a webpage where user can purchase a copy of PstViewer Lite. The page will
be opened in default browser.
 
When Start logging menu item is selected, application starts logging internal information into log file.
(User will be asked to specify its name and location) This file can be later sent to technical support to help
resolving problematic situations. See Logging article for more information.
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Open log file menu item opens log file, generated after selecting Start logging command, in default text
editor.
 
Check for updates menu item checks in newer version of PstViewer Lite is available.
 
Update settings menu item opens configuration dialog for updater. See Updating and update settings for
more information.
 
About menu item shows windows with information about PstViewer Lite and your license key.
 

Toolbar

Toolbar
 

 
PstViewer Lite Toolbar contains buttons used for quick access to a number of mail actions and search
tools.
 
By default, the buttons present on Toolbar are Open, Reply, Reply All, Forward, Search, Print, and
 Stop action buttons.
 
Please note, that elements of Toolbar are completely customizable. Check User interface tweaks article for
more details.
 

Mail actions items
 
Open toolbar button is used to open message file of one of the supported formats in PstViewer Lite.
Messages contained in selected file will be listed in Mail list.
 
Reply toolbar button opens default email client with a reply to a sender of a selected message.
 
Forward toolbar button opens default email client, forwarding selected message to selected recipients.
 
Reply All toolbar button opens default email client with a reply email to all senders.

Print toolbar button prints selected message using default printer and default printing settings.
 

Search items
 
Search edit box field can be used to make quick search in the messages opened in mail list.
 
Search button inside Search edit box field opens Search messages dialog, which offers advanced search
options. See Search messages dialog topic for more information.
 

Search messages dialog
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Search messages dialog
 

 
Search messages dialog is used to search contents of messages.
 
On Search tab user enters text in Text to search field. The specified text is searched for in message
headers and bodies.
 
On Advanced tab it is possible to specify in which part of message to perform search. Text can be
searched for in From, Subject, CC, From message properties, the whole Header text or Message
body.
 
Date block is used for date-limited searches. User can specify Start Date, End Date fields or both of
them to provide time limitation for searches. Please note, that value in End Date field should always be
later than value Start Date.
 
If Include subfolders in search option is checked, search will be performed recursively in specified folder
and its subfolders. Include *.eml and Include *.msg checkboxes allow limiting searches only for files of
certain type.

Match case enforces that hits have exactly the same case as the query. If this is disabled, the search is
case insensitive.

Match whole word only will only result in a hit if the match consists of an entire word, not if it's partial
(for example (but not limited to), whitespace separated). 

In Regular Expression, the query will be handled like a regular expression.

List of special characters:
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. - any character
\w - word character (letter or digit)
\d - decimal digit
\s - white-space character (space or tab)
* - 0 or more matches of the previous element
+ - 1 or more matches of the previous element
? - 0 or 1 match of the previous element
[ ] - group of symbols, for example [ABC]+ CAB - matches, CAD - doesn't match
\ - escape character "\." if you need dot symbol
| - OR operator, th(e|is|at) matches "the" and "this" in "this is the day"

After Match whole word only and Use regular expressions checkboxes are set to be active, Regular
expression will be searched among separate words of text that meets searching results. Modificators (‘ '̂,
‘$', \b) will be removed in case they were previously used.

 
For more detailed criteria of searching for messages, please see filtering options of Mail list.

Command line parameters

Command line parameters
 
Command line interface of PstViewer Lite can be accessed via PSTViewerLite.exe file, located in the
same directory as PSTViewer.exe.
 
 
Usage: PSTViewerLite.exe [options] [<file1> [<file2> ...]]
 
Options description:
 
 
h, help      
Show usage description.
Usage: PSTViewerLite.exe --help
 
 
a, associate
Associate specified file extensions with application.
Usage: PSTViewerLite.exe --associate <format[s]>
 
 
p, print
Print specified message to default or specified printer.
Usage: PSTViewerLite.exe --print <file[s]>
 
 
c, command
Load command line switches from specified file.
Usage: PSTViewerLite.exe --command <file>
 
 
w, nobrowse
Disable messages loading at startup.
Usage: PSTViewerLite.exe --nobrowse
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r, runprofile
Choose profile with GUI layout.
Usage: PSTViewerLite.exe --runprofile <profile name>
 
 
l, log
Turn on the log file.
Usage: PSTViewerLite.exe --log <file>
 
 
i, printer
Specify default printer.
Usage: PSTViewerLite.exe --printer <name>
 
 
k, key
Register the application with specified serial key for current user. Key will be applied during next start of
application.                
Usage: PSTViewerLite.exe --key <serial key>
 

delkey
Erase serial key for current user.
Usage: PSTViewerLite.exe --delkey
 
 
g, gui or GUIFLAGS
Configure visibility of GUI elements.
Usage:
PSTViewerLite.exe --gui <element1,element2[,...]>
or
PSTViewerLite.Setup-4.x.x.xxxx.exe GUIFLAGS="<element1,element2[,...]>
 
PSTViewer GUI elements:
· MLP - Mail list panel
· FEP - File explorer panel
· FTP - Favorites tree panel
· TBR - Toolbar
· MMP - Main menu panel
· SCH - Search elements
· CMZ - Customize GUI elements dialog
· NUP - Remove 'Check fro updates' and 'Update settings' options from the Help menu.
 
Toolbar buttons:
· OPF - Open file
· REP - Reply message
· FWD - Forward messages
· PRN - Print messages

 
 
UPDATE_POLICY
Choose update policy.It can be found in Help menu.
Usage: UPDATE_POLICY="Never" | "Ask" | "Auto"
 
Options for update policy:
· Never - Set 'Do not check for updates automatically' options in 'Updates Options' dialog;
· Ask - Set 'Check and prompt me to download and install the updates' options in 'Updates Options'
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dialog. This option is set by default;
· Auto - Set 'Check and automatically download and install' options in 'Updates Options' dialog.
 
 
GUILANG
Set the language for PstViewer Lite interface.
Usage: GUILANG="<language>"
 
The list of languages that PstViewer Lite supports:
1 Chinese.zh-CN
2 Chinese.zh-TW
3 English.en-US
4 French.fr-FR
5 German.de-DE
6 Italian.it-IT
7 Polish.pl-PL
8 Portuguese.pt-PT
9 Russian.ru-RU
10Spanish.es-ES
 
 
/exelang
Set the language for installation process.
Usage: /exelang <LangId>
 
The table with different <LangId> can be found here:
http://msdn.microsoft.com/en-us/library/bb165625%28VS.80%29.asp
 
Example (to install French version):
PSTViewerLite.Setup.exe /exelang 1036
 
 
<file_extension>_ASSOC
Associate PSTViewer with msg, eml, pst or/and ost files.
Usage:
· EML_ASSOC="1" - associate PstViewer Lite with eml files;
· MSG_ASSOC="1" - associate PstViewer Lite with msg files;
· PST_ASSOC="1" - associate PstViewer Lite with pst files;
· OST_ASSOC="1" - associate PstViewer Lite with ost files;
· ALL_ASSOC=1 - associate PstViewer Lite with msg, eml, pst an ost files.
 
 
Usage:
msiexec /i PSTViewerLite.Setup-4.x.x.xxxx.msi /qn PIDKEY="xxxxxxxx-xxxx-
xxxx-xxxx-xxxxxxxx" GUILANG="French.fr-FR" GUIFLAGS="FWD,REP,FTP"
ALL_ASSOC=1
 
or
PSTViewerLite.Setup-4.x.x.xxxx.exe /qn PST_ASSOC="1" MSG_ASSOC="1"
GUIFLAGS="FWD,REP,FTP,NUP"
 

Status bar

Status bar
 

http://msdn.microsoft.com/en-us/library/bb165625%28VS.80%29.asp
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Status bar shows description of hovered user interface elements, name and progress of current action,
number of messages in active folder and other information.
 

Docking Functionality

Docking Functionality
Docking functionality helps to set PSTViewer in convenient for user way by changing the default position of
the panels.
Basically, docking operations use drag-and-drop. Dock panels can be docked to the top, left, bottom or right
edge of a form (or user control).
Usage:  Start dragging and you will see exactly where the dragged panel can be docked. Small markers will
indicate sides where the panel is allowed to be docked (see the image below).
 

 
View menu contains  ‘Change docking to default' item that allows user to set all panels to default positions.
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Mail actions

Mail actions
 
Mail action is an operation that can be performed on messages or message groups. Some actions can be
performed on single messages only and some - on several messages.
 
Any actions that take time to perform can be stopped by pressing Stop button on the Toolbar.
 
 
Mail actions include:
· Opening
· Replying
· Forwarding
· Printing
· Saving
· Deleting
· Enumerating messages in folders
 
 
Opening. Opens message in default email client action.
 
Replying. An action of replying consists of creating a message following selected message in a default
email client. Sender of original message with be recipient of the new one.
 
Forwarding. An action of forwarding consists of creating a message in a default email client, containing
the copy of the original message to allow to forward it to different recipient.
 
Printing. An action of printing messages. Printing scale, paper size, background color, watermarks and
other options can be customized in Print preview window. Check Print preview article for more
information.
 
Saving. An action of saving a copy of selected message in specified folder. File name my be taken from
source message or specified directly.
 
Deleting. An action of deleting of selected messages. Messages inside containers (PST files) cannot be
deleted.
 
Enumerating. An action of retrieving a list of messages located in specified folder and (optionally) its
subfolders. See Mail enumerating article for more details.
 

Mail enumeration

Mail enumeration
 
Mail enumeration is an action of retrieving a list of messages located in specified folder and (optionally) its
subfolders. A result of enumeration is a Mail list filled with information about messages in current location.
 
Enumeration is automatically triggered when user selects a folder in Explorer tree or Favorites trees. It
can be manually triggered by selecting Refresh in Explorer tree context menu or Browse or Browse
with subfolders in Favorites tree context menu. In case of "with subfolders" option was selected,
enumeration will be performed in specified folder and recursively in all of its subfolders. Automatically
triggered enumeration will be performed recursively if Switch to scan with subfolders in Explorer tree
context menu is checked.
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The length of the process of enumeration depends on the number of messages in the folder. If the process
takes a noticeable amount of time, its progress will be displayed in status bar. The displayed information
include progress bar with status of the process, estimated completion time and estimated number of
messages found. Please note, that during the enumeration of PST files, we cannot precisely pinpoint the
amount of messages inside, until the reading of file is complete. So, estimated amount of messages can
differ from exact number after the reading is complete.

Saving mail

Saving mail 
 
Mail saving is an action, which consists of saving selected message to one of file formats according to
specified settings.
 
Supported formats

There are following formats to save your mail in available:

· PDF - Portable Document Format, created by Adobe Systems for document exchange. PDF is used for
representing two-dimensional documents in a manner independent of the application software, hardware,
and operating system.

· HTML - Hypertext markup language file; can be opened by any web browser, such as Microsoft Internet
Explorer or Mozilla Firefox.

· MHT - Web archive MHTML file; supported by Microsoft Word, Internet Explorer or Opera.
· TXT - Plain text file format; can be opened and edited by any text editor.
· PNG - Portable Network Graphics, a bitmap image format that employs lossless data compression.
· JPG - A commonly used method of compression for photographic images.
· GIF - A bitmap image file format.
· TIFF - A file format for storing images, including photographs and line art.
· BMP - A bitmap image file format from Microsoft Windows

Mail saving menu
 
You can save mail using main menu, or just with right-clicking on the email you need to save
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Configuration

Configuration

Settings

Settings
 

 
Settings dialog contains global application settings. It can be called from Settings item in the File menu.
 
Application font drop-down list can be used to specify the font that will be used in application as an
interface font. It is vital, that an Unicode font is selected for correct display contents of messages with
non-english symbols. Arial Unicode MS is set as a default font.
 
Delay before displaying message options are used to set up optimal response time. This is the delay
time after the message was loaded after its selection in Mail list and before appearance of its contents in
Message viewer. Lower values will cause message to appear more quickly, higher values will make
navigation through Mail list more smooth.
 
Possible values - disable, or from 100 to 2000 ms. Default value - 400 ms.
 
Language drop-down list can be used to change GUI language for PstViewer Lite. The current version
supports the next languages:
 
· English;
· French;
· German;
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· Italian;
· Polish;
· Portuguese;
· Russian;
· Spanish;
· Chinese Traditional;
· Chinese Simplified.
· Arabic;
· Filipino;
· Hindi;

If you do not see a specific language, you can localize PstViewer Lite by your own using L10NTool.exe

L10NTool.exe

L10NTool.exe
We provide L10NTool.exe with PstViewer Lite installation (you can find it in the Languages folder). After
running this tool you will get the next window:
 

 
 
Toolbar
 
Open button
 
Open button will display the next window:
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Choose Source file (the file that should be localized) and Target file (the file that will contain localized
information). Click Ok button. Now you can easily find the strings that are not localized (they are marked as
yellow strings):
 

 
 
To edit string you can double click on it:
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Save and Save as...
 
Allow to save created document.
 
 
Export untranslated
 
You can export all untranslated strings to one file. To do it click Export untranslated button:

 
 
Import
 
Import option allows to replace the strings in the opened file to strings in a new file:

 
 

File associations

File associations
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File associations dialog contains global application settings. It can be called from Associations item in
the File menu.
 
PstViewer Lite can be set as a default application to open MSG, EML, PST, MHT, MHTML and OST files.
File associations can be set using standard Windows file association window.
 
Please note, that it is impossible to un-associate PstViewer Lite with file types directly. To do this, you
should associate file types in question with different application using Windows file association interface.
 

User interface tweaks

User interface tweaks
 
PstViewer Lite offers a highly customizable interface system. It supports setting up the locations and
contents of interface elements and saving these customizations into profiles.
 

Interface customizations
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Toolbars position in the application window can also be changed by dragging them.
To change visibility of toolbars, right click on a toolbar to call context menu and select toolbars you wish
to show or hide.
 
To open Customization window, select Customize item in toolbar context menu. When this window is
opened, the order of menu and toolbar items can be changed using drag-and-drop.
 
Toolbars tab contains tools for creating, changing, deleting and resetting toolbars and menu. New items
can be added to menu and toolbar by dragging them from Commands tab to their preferred location on
panels.
 

Interface profiles
 
PstViewer Lite supports working with different graphical user interface profiles. GUI profile is a saved
configuration of GUI elements positions, sizes, menu and toolbar items.
 
To launch PstViewer Lite with custom user profile, use PSTViewerLite.exe --runprofile
<profile_name> command line parameter. All changes made to specified interface profile will be
saved.
 
If application was launched without custom interface profile, all GUI changes and modifications will be
applied to default profile.
 
 

Print preview

Print preview
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Print preview window provides advanced configuration options for printing files. It can be called from Print
preview item in the Mail menu.
 
Features:
· Printer selection and preferences
· Printing preview, single- and multi-page. Custom zoom level.
· Saving and loading documents in prnx format
· Margins adjustments
· Setting of background colors
· Adding text or picture as watermark
· Saving document in picture file (BMP, JPG, GIF, PNG, TIFF, WMF, EMF)
· Emailing document in a picture file
 

Updating and update settings

Updating and update settings
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PstViewer Lite has built-in system for checking if newer versions of application is available. User can
check for updates either manually, or allow application to do checks for newer versions periodically.
 
Manual update checks can be performed by pressing Check for updates item in Help menu. Parameters
of automatic updating systems can be set by selecting Update settings Help menu item.
 

Update options dialog

 
Check frequency group is used to set how frequently the check for updates is performed and if the
updates will be installed automatically.
 
If Do not check for updates automatically option is selected, PstViewer Lite will never check for newer
versions automatically.
 
If Check and prompt me to download and install the updates option is selected, application will
check for newer version with frequency, specified in Check frequency field. If the updates are found, user
will be asked if he wants to download and install these updates.
 
If Check and automatically download and install option is selected, PstViewer Lite will check for
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newer version with frequency, specified in Check frequency field. If the updates are found, they will be
downloaded and installed automatically (either all updates or critical only - as specified by user).
 
Downloads folders field sets the folder, in which temporary update files will be downloaded.
 
You can also set up update options while installation. Check Command line parameters article for more
information.
 

Logging

Logging
 
Logging is recording of internal information into the text file. This file can be later sent to technical support
to help resolving problematic situations or report bugs with PstViewer Lite.
 
Log contains basic information about user's operation system and internal information about application's
settings and performed actions. No personal information is collected.
 
Logging can be started by selecting Start logging item in Help menu. User will be asked to specify name
and location of the log file. After this, PSTViewer Lite will log its activity until the application will be closed.
 
Generated log file can be opened by selecting Open log file item in Help menu. The log file will be
opened in default text editor.
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Enterprise deployment

Enterprise deployment

Deployment

Deployment
PstViewer Lite installation is distributed as .EXE executable and as .MSI Windows Installer Package.
 
Executable version of installation is able to check if required components for PVP deployment are installed
in the system. If these dependencies are not installed, executable version will download and install them.
 
Installer Package version of installation is unable to download and install dependencies, but can be used
in remote software deployment systems. Please make sure, your PC meets minimum software
requirements before installing this version.
 
 

Registration

Registration
This topic covers the aspects of PstViewer Lite registration.
 
There are two different versions of PstViewer Lite available - with and without copy protection system:
 
· Protected version of PstViewer Lite require registration key to unlock full functionality. The software can

be evaluated with certain limitations without registering. The methods of registering application are
described below.
 

· Unprotected versions of PstViewer Lite have NoLP as part of their installation file names. They can be
installed and used with full functionality for unlimited period of time without requiring input of the
registration key.

 
All information below describes version of PstViewer Lite with copy protection.
 
 
Trial limitations
 
Without key PstViewer Lite has 15 days of free trial. After inputting a valid key this limitation is lifted.
 
 
Activation statuses
 
The activation status of current copy of PstViewer Lite can be seen in Help - Registration. These statuses
include:
 
· Active trial version. User may evaluate PstViewer Lite with trial limitations.

 
· Expired trial version. The trial period has expired, user must input registration key to continue using

PstViewer Lite.
· Fully functional version. A valid registration key has been inputted. User may use PstViewer Lite without

any limitations.
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Methods of registration
 
1. Registration via command line.
 
You can register PstViewer Lite via command line interface that can be accessed via PSTViewerLite.exe
file.
 
The next options are available for registration:
 
 
k, key
 
Register the application with specified serial key for current user. Key will be applied during next start of
application.                
 
Usage: PSTViewerLite.exe --key <serial key>
           
 
delkey
 
Erase serial key for current user.
 
Usage: PSTViewerLite.exe --delkey
 
  
2. Registration via Registration window.
 
 
PstViewer Lite can be registered manually via Help - Registration window. Write the key in Serial key field
and press Ok button. The registration procedure will be performed and if the key has been validated
successfully, the activation will be completed. You may require the internet connection to perform the
activation depending on your key type.
 
 
 
3. Registration while installation process.
 
 
You can register PstViewer Lite for all users while installation process. The next option is available for
such registration:
 
PIDKEY="<license_key>"
 
 
Usage:
PSTViewerLite.Setup-4.x.x.xxxx.exe PIDKEY="xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxx"
 
or
msiexec /i PSTViewerLite.Setup-4.x.x.xxxx.msi /qn PIDKEY="xxxxxxxx-xxxx-
xxxx-xxxx-xxxxxxxx"
 
where xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxx is your license key.
 

Command line switches

Command line switches
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PstViewer Lite installation files support all msiexec command-line options. For importing profiles via
command line, please see Profile deployment topic.
 
msiexec /Option <Required Parameter> [Optional Parameter]
 
Install Options
 
      </package | /i> <Product.msi>
 
              Installs or configures a product
 
      /a <Product.msi>
 
              Administrative install - Installs a product on the network
 
      /j<u|m> <Product.msi> [/t <Transform List>] [/g <Language ID>]
 
              Advertises a product - m to all users, u to current user
 
      </uninstall | /x> <Product.msi | ProductCode>
 
              Uninstalls the product
 
Display Options
 
      /quiet
 
              Quiet mode, no user interaction
 
      /passive
 
              Unattended mode - progress bar only
 
      /q[n|b|r|f]
 
              Sets user interface level
 
              n - No UI
 
              b - Basic UI
 
              r - Reduced UI
 
              f - Full UI (default)
 
      /help
 
              Help information
 
Restart Options
 
      /norestart
 
              Do not restart after the installation is complete
 
      /promptrestart
 
              Prompts the user for restart if necessary
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      /forcerestart
 
              Always restart the computer after installation
 
Logging Options
 
      /l[i|w|e|a|r|u|c|m|o|p|v|x|+|!|*] <LogFile>
 
              i - Status messages
 
              w - Nonfatal warnings
 
              e - All error messages
 
              a - Start up of actions
 
              r - Action-specific records
 
              u - User requests
 
              c - Initial UI parameters
 
              m - Out-of-memory or fatal exit information
 
              o - Out-of-disk-space messages
 
              p - Terminal properties
 
              v - Verbose output
 
              x - Extra debugging information
 
              + - Append to existing log file
 
              ! - Flush each line to the log
 
              * - Log all information, except for v and x options
 
      /log <LogFile>
 
              Equivalent of /l* <LogFile>
 
Update Options
 
      /update <Update1.msp>[;Update2.msp]
 
              Applies update(s)
 
      /uninstall <PatchCodeGuid>[;Update2.msp] /package <Product.msi | ProductCode>
 
              Remove update(s) for a product
 
Repair Options
 
      /f[p|e|c|m|s|o|d|a|u|v] <Product.msi | ProductCode>
 
              Repairs a product
 
              p - only if file is missing
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              o - if file is missing or an older version is installed (default)
 
              e - if file is missing or an equal or older version is installed
 
              d - if file is missing or a different version is installed
 
              c - if file is missing or checksum does not match the calculated value
 
              a - forces all files to be reinstalled
 
              u - all required user-specific registry entries (default)
 
              m - all required computer-specific registry entries (default)
 
              s - all existing shortcuts (default)
 
              v - runs from source and recaches local package
 
Setting Public Properties
 
      [PROPERTY=PropertyValue]
 
 
 
Consult the Windows ® Installer SDK for additional documentation on the command line syntax.
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